Public Assistance
Operations Manual
Stage 4
Purpose

The Operations Manual provides a concise description of the Public Assistance (PA) grant development process. It includes information and objectives on the four phases of grant development and staff roles and responsibilities throughout the phases.

General

PA Grants Manager
PA Grants Manager is used by FEMA employees to assign and track actions throughout PA project development and to collect all PA project-related information and documents, including correspondence.

Grants Portal
The PA Grants Portal is the Recipient and Applicant side of the Grants Manager. Recipients and Applicants use the GP to review and approve projects, upload documents, and track PA project development.

Emergency Management Mission Integrated Environment (EMMIE)
EMMIE is the official system of record for PA grant administration and funding. The CRC Document Integrity Unit (DIU) ensures all information and documentation in EMMIE matches the information and documentation in the PA Grants Manager.

Consolidated Resource Center (CRC)
PA staff deliver the program from the Joint Field Office (JFO) and receive support from the Consolidated Resource Center (CRC). The CRC is staffed with subject matter experts and specialized resources and support project development across disaster operations.
**Phase I – Operational Planning**

**Objective:** Identify Applicants’ disaster impacts and recovery priorities

---

**Region Develops Disaster Operating Profile**

Successful operations in Phase 1 begins with Regional leadership, Recipient, and the Infrastructure Branch Director (IBD) and Public Assistance Group Supervisor (PAGS) review of the event’s PDA data as well as any historical known data. They develop the Disaster Operating Profile based on this information and include:

- Information on the type of peril;
- State, Local, Tribe, or Territory capacity;
- Primary impacts from the event;
- Estimated disaster-related damage by Category of Work;
- Significant damage;
- Geographic considerations;
- Projected number of Applicants (including # of Private Non-profits);
- Projected number of Project Worksheets (PWs);
- Special considerations challenges;
- Mitigation opportunities; and
- Potential Other Federal Agency (OFA) involvement.
The IBD/PAGS and Recipient will develop and conduct a Disaster Overview Briefing for field and CRC staff. During the Briefing, IBD/PAGS and Recipient:

- review the Disaster Operating Profile
- establish the operational tempo of the event
- set overall expectations
- describe the level of participation by the Recipient
- present foreseen EHP concerns and mitigation opportunities

In Level I events—those projected to exceed $500M in eligible PA costs—Disaster Operating Profiles may be developed at a geographic branch level to provide greater detail.

**Recipient Conducts Applicant Briefings**
The Recipient conducts briefings for all potential Applicants. During these briefings, the Recipient provides high-level information regarding the PA Program.

**Applicant submits Request for Public Assistance**
If a State, Territorial, Tribal, or local government entity or PNP wishes to seek PA funding, it must first submit a Request for Public Assistance (RPA) to FEMA, through the Recipient, within 30 days of the respective area being designated in the declaration. The Applicant submits the RPA through the Grants Portal.

**Note:** In order for an Applicant to submit an RPA through the Grants Portal, the Applicant must establish a profile in Grants Portal. The Recipient will send invitations to Applicants to establish these profiles. In Level I events, to expedite funding, Applicants and Recipients may submit RPAs using paper forms. In such instances, Recipients or the Document Integrity Unit at the CRC will input information in the Grants Portal, Grants Manager, and EMMIE, and route the request for appropriate approval. If the Recipient or FEMA enters the RPA on behalf of the Applicant, they will set up a Grants Portal profile for the Applicant and will input the names/points of contact listed on the RPA. The Applicant will be responsible for assigning additional staff access to the Grants Portal.

Recipient reviews the RPA and submits eligibility recommendation to FEMA through the Grants Portal.

**PAGS Makes Applicant Eligibility Determination**
The PAGS, or a designee, reviews RPA for Applicant eligibility. Office of Chief Counsel (OCC) reviews RPAs from PNP s and special districts, sends eligibility recommendation to PAGS in the Grants Manager. PAGS makes Applicant eligibility determination in the Grants Manager. If the Applicant is not eligible, PAGS will discuss with the Recipient. PAGS drafts a Determination Memo and Letter which explains why the Applicant is not eligible. PAGS sends the Determination Memo and Letter to Recipient and Applicant.

CRC Document Integrity Unit inputs RPAs in EMMIE.

**JFO Conducts Training and Orientation**
The Joint Field Office (or Regional Public Assistance Staff if no Joint Field Office is established) train and orient all individuals involved to ensure they understand the Public Assistance grant development
processes. Training is provided for Recipients and potential applicants and FEMA and other federal staff. FEMA provides Grants Manager and Grants Portal hotline for questions that may arise after training. At training for federal staff, FEMA conducts an initial skills assessment to determine appropriate assignment of federal staff.

**JFO Supervisors Establish Lean Management Structure**

The Joint Field Office (or Regional Public Assistance Staff if no Joint Field Office is established), uses the information in the Disaster Operating Profile to establish an operational structure. This structure includes organizational charts that align with overall JFO structure as well as the establishment of lean management communication mechanisms including:

- Operational tempo with daily huddles and weekly coordination meetings;
- Huddle Boards—a communication and visual management tool to manage staff, identify cross-cutting issues, and build skills;
- Change Control Tool—a submission and tracking tool to manage program or disaster-wide process improvements;
- Sit-withs—a communication tool to identify and build individual staff skills; and,
- Day in the Life Of/Week in the Life Of (DILO/WILO)—a time management tool to improve focus and ensure tasks are completed before moving to the next.

**PAGS or PD TFL Assigns PDMG**

Program Delivery Manager (PDMG) is the Applicant’s single point of contact during PA grant development. Prior to assigning Applicants to PDMGs, PAGS and Program Delivery Manager Task Force Leader (PD TFL) conduct an initial sit-with with PDMGs to assess knowledge, skills, and abilities. PAGS and PD TFL assesses Applicant complexities and identifies appropriate PDMG. PAGS or PD TFL makes Applicant assignment to PDMG in Grants Manager.

**PDMG Completes Exploratory Call**

After an Applicant is assigned to a PDMG, the PDMG conducts an Exploratory Call with the Applicant. PDMG coordinates with the Recipient point of contact if the Recipient wants to participate in the call. The objectives of the Exploratory Call are:

- Introduce role of a PDMG and explain the Public Assistance grant program
- Discuss the disaster damages the Applicant has identified
- Introduce the Damage Inventory
- Discuss high-level documentation needed to support the Applicant’s claims (e.g. insurance, procurement policy, pay policy)
- Discuss and schedule the Recovery Scoping Meeting

During the Exploratory Call, the PDMG discusses the Applicants points of contact for the damage and requests those individuals attend the Recovery Scoping Meeting. After the call, the PDMG enters the results of the call schedules the Recovery Scoping in the Grants Manager.

The PDMG uses the results of the Exploratory Call to tailor the agenda of the Recovery Scoping Meeting, a detailed and in-depth meeting regarding the Applicant’s disaster damages.
Applicant Completes Initial Damage Inventory
The Damage Inventory is used by the Applicant to capture all disaster-related damage claims. Applicants must identify and report all damages on the Damage Inventory within 60 days of the Recovery Scoping Meeting. The Damage Inventory is located in the Grants Portal. PDMG can add line items to the Damage Inventory on behalf of the Applicant in the Grants Manager.

In advance of the Recovery Scoping Meeting, the PDMG works with the Applicant to input an initial Damage Inventory. This allows the PDMG, Applicant, and Recipient to have an in-depth discussion about disaster-related damage claims during the Recovery Scoping Meeting.

PDMG conducts Recovery Scoping Meeting
The Recovery Scoping Meeting is the first substantive meeting between the Applicant, Recipient, and FEMA which starts the 60 day regulatory timeframe for the Applicant to identify and report damage. The objectives of the meeting are:

• Discuss the Damage Inventory
  o Discuss Public Assistance (PA) general eligibility
  o Discuss project formulation for categories of work
  o Discuss logical groupings for sites that require inspections
  o Discuss special considerations
    ▪ Environmental Planning and Historic Preservation issues
    ▪ Insurance requirements
    ▪ Mitigation opportunities

• Discuss documentation required to support the Applicant’s claim
  o Review documentation the Applicant has submitted

• Utilize the Essential Elements of Information questionnaires to determine additional documentation or information needed Schedule Site Inspections
  o Confirm Applicant’s capability and capacity to participate in site inspections and grant development
  o Schedule site inspections

• Develop Program Delivery Plan
  o Populate a 60-day calendar with follow-up meetings
    ▪ EEI
    ▪ Debris PAAP
    ▪ Damage inventory deadline

Prior to the meeting, the PDMG will coordinate with Recipient, EHP, and Mitigation for participation in the Recovery Scoping Meeting.

NOTE: Neither EHP or Mitigation is able to assign Specialists to the Recovery Scoping Meeting in the Grants Manager. This will change in a future Grants Manager update.

After the Recovery Scoping Meeting, the PDMG enters the results of the meeting in the Grants Manager and transitions the Applicant to Phase II – Damage Intake and Eligibility Analysis.
Phase II – Damage Intake and Eligibility Analysis

Objective: Capture Applicant’s disaster-related damage and determine eligibility within 60 days of the Recovery Scoping Meeting

PDMG Assess Facility Eligibility
PDMG assesses the eligibility of facilities on the Damage Inventory. If the PDMG finds an eligibility issue with a facility claim, the PDMG will discuss with the PDTFL and PAGS to confirm the eligibility recommendation. If the facility is not eligible, PAGS will discuss with the Recipient. Then PAGS will direct PDMG to send a notification to the CRC to draft the Determination Memo and Letter which explains why the facility is not eligible. PAGS sends the Determination Memo and Letter to Recipient and Applicant.

PDMG Logically Groups Damage into Projects
Based on the discussion during the Recovery Scoping Meeting, PDMG groups damages on the Damage Inventory into projects in the Grants Manager. This allows all interested parties to track the activities related to the project.

First, the PDMG designates which lane in the CRC will develop the project:
- **Completed/Fully Documented**: work is 100% complete on all sites on the project and the Applicant has documentation to support the work.
  - No inspections conducted for these projects/sites.
- **Standard**: projects with work to be completed that do not require highly technical skills to develop the DDD in the field and SOW/costs in the CRC
- **Specialized**: projects with work to be completed where technical skill sets needed to develop the damage description in the field and the scope of work and costs at the CRC.

PDMG Sends Request for Essential Elements of Information (EEI) to Applicant
PDMG develops the EEI request based on the results of the Recovery Scoping Meeting. PDMG sends the EEI request to the Applicant through the Grants Manager. The EEI request details the documentation and information needed to support the damage claims. Applicant receives the EEI request through the Grants Portal.
PDMG Submits Site Inspection Work Order Request
PDMG assess whether the type of site inspection needed – Standard or Specialized. Then PDMG sends a Site Inspection Work Order Request to the Site Inspector TFL through the Grants Manager. The Site Inspection Work Order Request details the sites to be inspected, the time/date of the site inspection, the Applicant’s point of contact for the inspection, and other pertinent information to prepare the Site Inspector for the inspection.

The Site Inspector TFL assess the skill sets needed to conduct the inspection and assigns Site Inspector(s) and/or Site Inspector Crew Leaders to the work order in the Grants Manager. Once the Site Inspector TFL confirms the work order, an automated email will be sent to the PDMG, Applicant, Applicant’s point of contact for the site inspection, PD TFL, Site Inspector, Site Inspector TFL, Environmental and Historic Preservation (EHP) and Mitigation with the Site Inspection Work Order information. The Site Inspection Work Order can be viewed in both the Grants Manager and Grants Portal.

Site Inspector or Technical Specialist Conducts Site Inspection
One day prior to the scheduled inspection, the Site Inspector will contact the Applicant’s representative to confirm the work order (i.e., time, date, location, sites to be inspected, work complete). Site Inspector also coordinates with EHP and Mitigation, if participating in the inspection.

**NOTE:** EHP is able to assign Specialists to a Site Inspection Work Order. Mitigation will have this capability in a future update to the Grants Manager.

Site Inspector conducts the site inspection with the Applicant and uses the Site Inspection report to capturing damage identified. The Site Inspection Report prompts the Site Inspector to capture:

- Description of the facility
- Exact dimensions of the damage, including the specific materials and the size/capacity/model of the damaged components
- Cause of damage, confirm damages were caused by the incident, and damages occurred during the incident period
- Applicant’s method of repair for each damage line item being inspected
- Sketch of site to capture profile, and cross sectional perspectives.

Throughout the site inspection, the Site Inspector affirms with the Applicant all damages captured on the SIR, ensuring that measurements and quantities shown by the Applicant are accurately reflected on the SIR. At the conclusion of the inspection, the Site Inspector requests the Applicant review and provide concurrence on the SIR by initialing and dating each page of the SIR.

After the inspection, the Site Inspector enters the results of the inspection in the Grants Manager which develops the Damage Description and Dimensions (DDD). The Site Inspector also uploads photos and other information captured during the inspection. The Site Inspector sends the DDD to the PDMG through the Grants Manager.
PDMG Reviews the Site Inspection Report and DDD
PDMG reviews the Site Inspection Report and DDD in the Grants Manager. PDMG discusses issues identified during the site inspection with the PD TFL. If needed, PDMG coordinates with Applicant to gather additional information or schedule additional site inspections.

PDMG also reviews site inspection reports from EHP and Mitigation. If EHP or Mitigation did not attend the site inspection, PDMG will coordinate with EHP and/or Mitigation to review the DDD or proposed method of repair for EHP concerns or mitigation opportunities.

Applicant Submits EEI Documentation
As Applicant gathers documentation, Applicant will respond to the specific EEI requests for each project. When all EEI items have an associated document or comment, Applicant will return the EEI to the PDMG through the Grants Portal. PDMG reviews the EEI responses to ensure the information provided satisfies the EEI request. Once all documentation submitted, PDMG marks “EEI complete” in the Grants Manager.

PDMG Assesses Work Eligibility
- For Standard and Specialized projects, the PDMG assesses the damage to the facility and proposed method of repair. PDMG then assess the work for PA eligibility.
- For Completed/Fully Documented projects, the PDMG does a cursory review of the work claims for eligibility.

If the PDMG finds an eligibility issue with a work claim, the PDMG will discuss with the PD TFL and PAGS to confirm the eligibility recommendation. If the work is not eligible, PAGS discusses with the Recipient. Then PAGS directs PDMG to send a notification to the CRC to draft the Determination Memo and Letter which explains why the work is not eligible. PAGS sends the Determination Memo and Letter to Recipient and Applicant.

Applicant Reviews & Signs DDD
After the PDMG reviews the DDDs in the project, the PDMG sends the DDD to the Applicant for review through the Grants Manager. PDMG discusses the DDD with the Applicant and then gathers information to answer the Development Guide Questions (see next step). The Applicant reviews and approves the DDD in the Grants Portal.

NOTE: There is not a Recipient DDD review in the Grants Portal. If the Recipient wants to review DDDs, the PAGS will provide guidance to PDMGs.
REMINDER: Action only occurs for Standard and Specialized Projects. Applicant will review Completed projects after the DDD, SOW, and costs are developed.

PDMG Completes Development Guide Questions
After the Applicant approves the DDD(s), the project will return to the PDMG for ‘Scope and Cost Routing.’ The PDMG will complete the Develop Guide Questions in the Grants Manager. The Development Guide Questions detail:
- Who will develop the Scope of Work and costs – FEMA or Applicant
- Method of repair
- Historic costs, if applicable
- Identified 406 Mitigation opportunities and whether the Applicant is interested in pursuing
- Confirmation that PDMG discussed identified EHP concerns

**REMINDER:** This action only occurs for Standard and Specialized Projects.

**PDMG Submits Project to CRC**

For Completed/Fully Documented projects, the PDMG sends the project to the CRC after the EEI is complete.

For Standard and Specialized projects, the PDMG sends the project to the CRC after completing the Development Guide Questions.

**NOTE:** All projects will go to the CRC – even if the Applicant elects to develop the SOW/costs. The CRC will not take action on those projects until the Applicant provides the SOW/costs. The PDMG tracks these projects and regularly check with the Applicant on the status of the SOW/cost development.
# Phase III

**Objectives:**
- CRC develop the DDD/SOW/costs for Completed/Fully Documented projects
- CRC develop the SOW/costs for Standard and Specialized projects
- CRC validate Applicant-provided SOW/costs for work to be completed
- Obtain Applicant signature on projects

**Completed/Standard/Specialized Lane Lead Assigns Specialist**
CRC Lane Leads assess complexity of project and skill sets needed to develop the project. CRC Lane Lead assigns the project to a CRC Specialist.
- Completed/Fully Documented Lane: Validation Specialist
- Standard Lane: Costing Specialist
- Specialized Lane: Technical Specialist

**NOTE:** Once the CRC receives the project, the Document Integrity Unit creates a project shell in Update Applications in EMMIE. The DIU ensures all project-related information and documentation in Grants Manager is reflected in EMMIE.

**CRC Specialist Develops or Validates the Scope of Work and Cost**
CRC Specialists review Applicant-provided documentation and develops/validates the Scope of Work and costs for the project.
Peer Review
Projects then go through a peer review within their respective lanes. Original CRC Specialist clicks “Complete Scoping and Costing” in Grants Manager.

CRC Specialist Assess Work and Cost for Eligibility
CRC Specialist assess the work and costs and makes an eligibility recommendation. If the CRC finds an eligibility issue with a work or cost claim, the CRC Specialist discusses with the Lane Lead. If the Lane Lead concurs, the Lane Lead discusses with the PDMG, PD TFL and PAGS to confirm the eligibility recommendation. If the work or cost is not eligible, PAGS discusses with Recipient. Then PAGS directs PDMG to send a notification to the CRC to draft the Determination Memo and Letter which explains why the work or cost is not eligible. PAGS sends the Determination Memo and Letter to Recipient and Applicant.

Program Compliance Lead Routes and Assigns Staff
Program Compliance Lead assess the project to determine the required Compliance Evaluations. Program Compliance Lead assigns a Quality Assurance Specialist in Grants Manager and assigns the appropriate evaluation queues in Grants Manager and EMMIE.

Program Compliance Evaluations
- **Quality Assurance Evaluation**: Quality Assurance Specialist in the CRC completes quality assurance evaluation using the Quality Assurance Checklist. The evaluation is completed in Grants Manager and EMMIE (Initial Review).
- **Insurance and Mitigation Evaluations**: Insurance Specialists and Mitigation Specialists complete their respective evaluations in Grants Manager and EMMIE.
- **Minimum Threshold Evaluation**: Insurance Specialists assess whether insurance reductions, if applicable, reduce the project cost below the minimum project threshold, making the project ineligible. The Insurance Specialist contacts the PDMG who notifies the Applicant. PAGS discusses with the Recipient. CRC drafts the Determination Memo and Letter which explains why the project is not eligible. PAGS sends the Determination Memo and Letter to Recipient and Applicant.
- **EHP Evaluation**: EHP completes the EHP evaluation and places all conditions on the project in Grants Manager and EMIS.
Phase IV

**Objective:** obligate projects, complete the Recovery Transition Meeting with the Applicant, and transition Field Operations to the Region

**PDMG Review** → **Recipient Review** → **Applicant Reviews and Signs Project** → **Final Review / Award in EMMIE** → **PDMG Conducts Recovery Transition Meeting** → **Transition Field Operations to Region** → **CRC Completes All Initial Sub-Awards**

**Reviews**
- **PDMG Review:** Once EHP completes its evaluation in Grants Manager, the PDMG gets the project for review. PDMG reviews the project and concurs in Grants Manager.
- **Recipient Review:** Recipient reviews the project in Grants Manager and EMMIE.
- **Applicant Reviews and Signs Project:** Applicant reviews and signs project through Grants Portal.
- **Final Review/Award in EMMIE**
  PAGS (or designee) reviews project, submits the RAA in NEMIS, and obligates the project in EMMIE.

**REMINDER:** PAGS, or designee whom completes Final Review, will not complete Final Review until the Applicant reviews and signs the project through the Grants Portal

**PDMG Conducts Recovery Transition Meeting**
The Recovery Transition Meeting is a **formal transition briefing** from FEMA back to the Recipient. PDMG submits a request to conduct the Recovery Transition Meeting through the Grants Manager. The request goes to the PD TFL and PAGS for review. Once approved, the PDMG coordinates with Recipient and Applicant and schedules the Recovery Transition Meeting in the Grants Manager. Once the PDMG schedules the Recovery Transition Meeting, an email notification goes to the Applicant and Recipient. After conducting the meeting, the PDMG enters the results of the discussion in the Grants Manager. Then the Applicant signs an acknowledgement of the Recovery Transition Meeting completion in the Grants Portal.

**Transition Field Operations to Region**
Regional leadership continuously evaluate progress and determine when and how field operation end.

**CRC Completes All Initial Sub-Awards**
The CRC continues to develop projects until all initial sub-awards are completed.